Steps to Batch Replicate Testing Sessions

Overview

With release of TOPSpro Enterprise Online Version: 2.0 Build 299, the **Batch Replicate** feature was introduced to copy multiple **Testing Sessions** from the current program year (July 1, 2015 – June 30, 2016) to the new program year (July 1, 2016 – June 30, 2017).

The CASAS Technology Support Team at techsupport@casas.org is available to provide technical assistance if needed. This e-mail address alerts several members of the team to ensure you receive a timely response. Team members are available 6:00 am – 5:00 pm (Pacific), M – F, and may also be contacted at 1-800-255-1036, option 2.

<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1.</strong></td>
<td><img src="https://i.imgur.com/0.png" alt="TE Client" /></td>
<td>• To access TOPSpro Enterprise Online for the first time on a local computer,&lt;br&gt;  ○ At top left of the web browser window,&lt;br&gt;     ▪ <strong>Click (Install) link.</strong>&lt;br&gt;  • A client application will install on the local computer to connect with the online server.</td>
</tr>
<tr>
<td><strong>2.</strong></td>
<td><img src="https://i.imgur.com/1.png" alt="TE Client" /></td>
<td>• A TE shortcut icon is automatically placed on the computer desktop.&lt;br&gt;  • If you are a user who will access TE frequently, you may want to pin the shortcut icon to your <strong>Taskbar</strong> along the bottom of your computer monitor for quick access when other applications are open on your screen.</td>
</tr>
<tr>
<td><strong>3.</strong></td>
<td><img src="https://i.imgur.com/2.png" alt="TE Client" /></td>
<td>• TE opens to a log in screen similar to <strong>eTests Online</strong> except that you need to specify the <strong>Server</strong> from the drop-down menu.&lt;br&gt;  ○ <strong>Click the Server field down-arrow.</strong>&lt;br&gt;  ○ <strong>Click to select the Server in your state.</strong></td>
</tr>
</tbody>
</table>
4. The Testing Sessions list of records opens to display sessions from all program years.

5. To view a list of Testing Sessions from TE as seen in eTests Online,
   - Click Organization, and then
   - Click Testing Sessions.

6. Users may have access to different menus and data functions in TE based on the TE Access Group in which their user account is placed.
   - Contact your agency’s online data manager if needed for access.

   Users enter the same log in credentials to access eTests Online and TE Online because there is only one database shared between both applications.
   - Enter User credentials.
   - Click Connect to establish connection to the online server.

   To filter for Testing Sessions in the 2015-16 program year,
   - From the Toolbar at top left of the list,
     - Click the Filter icon from the Program Year column header.
   - From the Program Year drop-down menu,
     - Check 7/1/2015 - 6/30/2016.
<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
</table>
| 7.   | ![Testing Session Display](image1) | • At least two **Testing Session** records must be selected to activate the **Batch Replicate** function.  
  • To select multiple **Testing Sessions**,  
    - Use the Ctrl + A key-command to select all sessions listed in consecutive order.  
    - OR –  
    - Use the Ctrl + Click key-command to select non-consecutive sessions from the list. |
| 8.   | ![Testing Session Display](image2) | • After selecting **Testing Sessions**,  
    - Click **Batch Replicate** from –  
      - The **Toolbar** at top of the list of **Testing Session** records.  
      - OR –  
      - The **More** button at top right of the list of **Testing Session** records. |
| 9.   | ![Testing Session Display](image3) | • To replicate selected **Testing Sessions** in the 7/1/2016 – 6/30/2017 Program Year,  
    - Click **Replicate Sessions** at bottom of the pop-up window. |
| 10.  | ![Testing Session Display](image4) | • To confirm replicating the selected **Testing Sessions** –  
    - Click **Yes**.  
    - OR –  
    - Click **No** and repeat Steps 7 – 9. |
<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
</table>
| 11.  | ![Batch Replicate wizard](image) | • The **Batch Replicate** wizard will begin replicating selected **Testing Sessions** for the new program year starting 7/1/2016.  
  - **Please wait…** |
| 12.  | ![Pop-up message](image) | • A pop-up message will display when all selected **Testing Sessions** have been replicated.  
  - **Click OK** to close the pop-up message. |
| 13.  | ![Filter icon](image) | • To see a list of replicated sessions for the new **Program Year**,  
  - From the **Toolbar** at top left of the list,  
    - **Click** the **Filter** icon from the **Program Year** column header.  
  - From the **Program Year** drop-down menu,  
    - **Check** 7/1/2016 - 6/30/2017. |
| 14.  | ![Testing Sessions list](image) | • The **Testing Sessions** list of records now displays replicated sessions for the 7/1/2016 – 6/30/2017 **Program Year**. |
| 15.  | ![Testing Sessions list](image) | • **Testing Sessions** for the 7/1/2016 – 6/30/2017 **Program Year** will also be listed and ready to use in **eTests Online**. |
Steps to Create Testing Sessions

Overview

To get up and running smoothly with testing in the new program year, you may want to start “fresh” with establishing Instructional-Program Templates in your eTests Online account. These templates will ensure standardized test delivery with NRS approved assessments for WIOA compliance and College and Career Readiness (CCR).

- Creating Testing Sessions is a one-time task as when registering computers.
- Only certified coordinators may create, edit, copy, or delete Testing Sessions.
- Coordinators establish a Template to ensure standardized test delivery for all programs using eTests Online.
- From this Template, sets of sessions are added and customized based on recommended best practices.
- Templates are site-specific.
  - Any edit to an instructional-program Template at each site will have a simultaneous effect in editing all sessions sharing the same Template at that site.
- If you have more than one lab at a site, additional sets of sessions must be added for proctors to manage per lab.
  - The session description (not the Template) should include the lab name.
- The set of sessions may be copied to quickly add additional sessions.
  - Sessions sharing the same Template within the same site may be copied in any order.
  - The first session copied to a new site will establish the Template at that site so it is very important to copy the first session in a Template set of sessions to establish the Template at the new site.
- After sessions are added, they are ready to use and reuse whenever testing is needed throughout the program year.
  - Reusing sessions ensures standardized test delivery and testing practices.
  - The most-used sessions in a set are the pretest and post-test sessions, and remaining sessions are used “as needed.”
Testing Sessions

- Multiple sessions may be active simultaneously to deliver tests according to the session description.

- We recommend that you *not* assign stations to sessions so that proctors have maximum flexibility of adding any station to any active session on an ad-hoc basis.

- Stations will deliver tests for any testing purpose as described.
  
  - **Intake/pretest** sessions allow new student records to be added at time of testing and align with the recommended CASAS Intake Process for accurate test results and program placement. Refer to CASAS NRS Levels and Grade Levels for WIA Title I or CASAS and NRS Levels for WIA Title II for level placement.
  
  - **Progress/Post-test** session locks creation of new student records so that students must enter a pre-existing ID to ensure they are presented with the appropriate level post-test based on their most recent tests recorded in the online database. The recommendation is to post-test after 70-100 hours of instruction (40 hours minimum) to document learning gains.
  
  - **Retest** session gives you the opportunity to retest students on the same day if their pre-/post-test score is below accurate range (* – retesting required, or conservative estimate (s) – retesting recommended. The online system automatically adjusts to present the appropriate next-assigned test (NAT).
  
  - **Returning** session should be used when students return after being absent from instruction (NRS recommends 90+ days). This session re-administers the locator to determine the next appropriate-level test at time of return.
  
  - **Registration** session affords the opportunity to separate the registration process from the testing process and gives you undivided time with students to assist them in applying their responses on data collection screens and addressing any questions. Refer to Data Collection Details. Students are also given the opportunity to practice taking a web-based test.
    
    \*If you use the Registration session, data collection screens are skipped during an intake session and students can begin testing.

    \*If you do not use the Registration session, students will complete the registration process during the intake session before they begin testing.

  - **Practice** session may be administered any time and multiple times. No results are recorded. The purpose of this session is to introduce students to CASAS web-based test delivery, not for determining basic skills. Lab assistants may allow students to practice any time, and instructors may incorporate practice in classroom lessons.

- Test results are immediately accessible in both eTests and TOPSpro Enterprise Online. This includes generating reports in TE such as the Individual Skills Profile and Student Competency Performance report.
The following displays for each step to Create Testing Sessions were put together for hands-on lab training with multiple users at the 2016 CASAS National Summer Institute. To proceed, we ask that you substitute the following references when working through each step. A version with updated displays will be posted to our website soon!

**Template Name:**

- In place of the “unique” Template name of “Rabbit”
  - Use an Instructional Program name or acronym such as –
    - ABE for Adult Basic Education
    - ASE for Adult Secondary Education (includes HSD and HSE programs)
    - CIT for Citizenship
    - ESL for English as a Second Language
    - ELL for English Language Learners
    - ESOL for English for Speakers of Other Languages
    - HSD for High School Diploma
    - HSE for High School Equivalency

**Validity Period:**

- In place of 7/1/2015 – 7/1/2016
  - Use 7/1/2016 – 7/1/2017

<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | Testing Sessions: ![Image](testing_sessions.png)  
Test Results  
Students  
Testing Stations  
Settings | ![Image](testing_sessions_list.png)  
- From eTests Online Application Management,  
- Click Testing Sessions. |
| 2.   | ![Image](testing_sessions_list.png)  
The Testing Sessions list opens to display –  
- Session Name  
- Site  
- Start/End Dates and Times  
- Proctor supervising the session  
- Status of the supervised session  
- By default, the list filters sessions in the Current Program Year, by  
  - Site, and then by the  
  - Session Full Name |
### Step 3

<table>
<thead>
<tr>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Testing Sessions" /></td>
</tr>
</tbody>
</table>

#### Description
- The first session you will create is to establish an *Instructional Program Template* to ensure standardized test delivery.
  - From this *Template*, you will add customized sessions based on best practices.
- You will spend the most time configuring the *Template* which also creates the first session in a set of customized sessions sharing the same *Instructional Program Template* name.
  - All other sessions that are added require only minor edits, or customization.
- Now let’s get started. At bottom of the *Testing Sessions* list,
  - Click *Create new Session*.

### Step 4

<table>
<thead>
<tr>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Edit Session Details" /></td>
</tr>
</tbody>
</table>

#### Description
- A new session window opens in *Edit* mode.
- With this first session, you are establishing the *Instructional Program Template*.
- The *Template* ensures standardization among all sessions sharing the same *Template*.
- The *Template Name* should *not* be changed when customizing *Sessions* sharing the same *Template* as doing so will result in non-standardized testing for the *Instructional Program*.

### Step 5

<table>
<thead>
<tr>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Template Name: Rabbit" /></td>
</tr>
</tbody>
</table>

#### Description
- Substitute “Rabbit” for
  - ABE, ASE (or HSD, HSE), CIT, ESL, etc.
- To establish an *Instructional Program Template Name*, at left of the *Edit Session Details* screen,
  - Enter an *Instructional Program* name or acronym.
<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
</table>
| 6.   | ![Image](image6.png) | - To continue,  
  - Click the Site-field **down-arrow**.  
- From the drop-down menu,  
  - Select your Site. |
| 7.   | ![Image](image7.png) | - It is recommended that you *not* assign Stations to sessions to give Proctors maximum flexibility of adding any station to any “active” session on an ad-hoc basis.  
  - Stations will deliver tests for any testing purpose described in the Session Description. |
| 8.   | ![Image](image8.png) | - The Students tab may be used to apply a specific configuration for a student or group of students such as –  
  - overriding the next-assigned test (NAT), or  
  - applying accommodations such as large screen display, or different test times.*  
- **Student Configurations** remain indefinitely so we would caution you on using this feature.  
  - For example, you must **remove** a Student Configuration if overriding the NAT otherwise, the student will continually take the same test. |
| 9.   | ![Image](image9.png) | - The first session in a set of sessions sharing the same Template establishes both the –  
  - First Session, and  
  - Template Configuration.  
- An Instructional Program Template controls standardization for –  
  - What and how tests are delivered, and  
  - What is collected and displayed during test delivery. |

*See [Accommodations Guidelines](#) on the CASAS website for more details.*
## Testing Sessions

<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
</table>
|      | ![Template and first Session](image) | • After the session is saved, the Template and first Session is established.  
• From this point forward, any edit to the Template will simultaneously edit all Sessions sharing the same Template, but only within the same Site. |
| 10.  | ![Edit Session Details](image) | • The first session is one of three Intake sessions which –  
  o Allow new student records to be added at time of testing, and  
  o Align with the recommended CASAS Intake Process for accurate test results and program placement. |
|      | ![Session Description](image) | • At right of the Edit Session Details screen is the Session Description field to specify what makes this session unique among the set of sessions you will create.  
• If you have more than one Lab at each site, all Session Descriptions, not the Template, should include the Lab name.  
• To put this into practice,  
  o First, enter the word LAB.  
  o Followed by the name or abbreviation of the Lab at your Site, such as AC for Assessment Center.  
• Then, enter the Session Description.  
  o Intake: Locator + Pretest. |
| 12.  | ![Validity Period](image) | • The recommended Validity Period for all sessions is the Program Year (PY) date range of July 1 through June 30 of the following year.  
  o Sessions may be used and reused whenever testing is needed throughout the program year. |
Step | Display | Description
---|---|---
13. | ![Session Configuration](image1).png | - Reusing sessions ensures standardized test delivery and testing practices.

**Note!** By default, sessions expire at midnight.

- This is why the **To** date is set for **7/1/2017**.
  - i.e., sessions expire 6/30 midnight.

14. | ![Session Configuration](image2).png | - To put this into practice,
  - **Click** the **From** field **down-arrow**.
  - From the drop-down **Calendar**,
    - **Select** 7/1/2016.

*The **Life and Work Reading** series offers three options with different forms and focus at **Level C**.

**Life and Work** emphasis at **Level C**
- 81, 82, 83, 84, 85, 86, 185, 186, 187, 188

**Life** emphasis at **Level C**
- 81, 82, 83, 84, 185, 186, 187, 188

**Work** emphasis at **Level C**
- 81, 82, 83, 84, 85, 86, 187, 188

- The first tab to configure is **Modalities** to specify what gets delivered.
- The recommendation is to create separate **Templates** per instructional program such as ABE, HSD, or HSE that only delivers reading and math, and ESL that only delivers reading and listening.
  - For training purposes, these steps direct you to select **NRS-approved assessments** to serve multiple programs combined.

- For **Modalities**, you will apply **three** settings.
  1. **Check Reading**.
  2. **Click** the **Reading** field **down-arrow**.
  3. From the drop-down menu,
    - **Select** a **Life and Work** option.*

- By default, the **Short Computer-Adaptive Test**, or **CAT, Form 102R** known as the **Reading Locator**, is automatically set as a short appraisal to determine and present an appropriate-level reading pretest in the same sitting.
  - 7 - 9 test items will be drawn at random from the test delivery system.
### Step 15. Check Math.

- Click the Math field **down-arrow**.
- From the drop-down menu,
  - Select **Life Skills Math (LS Math 30 series)**
- By default, the **Math Locator, Form 102M**, is also set automatically followed by a pretest in the same sitting.

### Step 16. Check Listening.

- Click the Listening field **down-arrow**.
- From the drop-down menu,
  - Select **Life and Work Listening – 980 series**
- The **Listening Locator, Form 89L**, is also set automatically and will be followed by a pretest in the same sitting.
  - The **Listening Locator** is **not** adaptive and instead is a fixed-form with 9 items divided into 3 sets per item type.

### Note!
Typically, **Templates** are established for each **Instructional Program**. For example,
- ABE to delivery reading and math, and
- ESL to deliver reading and listening.

### Step 17.
The next tab to configure is to specify **how tests are delivered**.
- Click the **Options** tab.
- The online system uses a **three-state model** for all settings.
- In user **Edit** mode, all boxes initially display with a **dash**.
  - A **Dashed** box indicates no specific setting.
Testing Sessions

<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>18.</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td></td>
<td><img src="image3.png" alt="Image" /></td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
</tbody>
</table>

- **Click Inherited.**
  - This allows you to see default system settings that sessions will inherit unless enabled or disabled in user **Edit** mode.
  - A **Checked** box represents a setting that is enabled.
  - An **Empty** box is a disabled setting.

**Note!** As you work through this tutorial, you will be directed to apply specific settings and leave other settings “as-is” for optimal system performance and for maximum benefit if/when an edit needs to be made to the **Template**. Any edit to an instructional-program template at each site will have a simultaneous effect in editing all sessions sharing the same template at that site. (i.e., inherit the edit). Therefore, many boxes will display a dash indicating an inherited state (recommended).

| 19.  | ![Image](image5.png) | ![Image](image6.png) |
|      | ![Image](image7.png) | ![Image](image8.png) |

- You will apply only **two** edits on the **Options** tab based on recommended best practices.

- **Click Edit**, and in user edit mode,
  1. **Check Allow ‘I don’t know’ on locator/appraisal.**
  - Because the **Locator** is computer-adaptive, this will allow students to skip an item without responding.
  - This setting is recommended to help ensure accurate **Locator** results for determining an appropriate-level pretest.
  2. **Click and clear box** on **Allow student to select class from other sites** so that you have an empty box to disable the setting.
  - You are disabling this setting based on recommended best practices.

- Because the online system tracks students and programs across multiple sites and classes through a unique **ID**, assigning a class to the test record is no longer necessary or required.
  - Without this restriction, test results may be used for multiple classes and programs to avoid over testing.
<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
</table>
| 20.  | ![Options Tab](image) | • To verify all settings on the **Options** tab,  
  o **Click Effective.**  
    ▪ This shows you a combination of user **Edit** and System-Inherited defaults combined.  
  • Note that standard **test administration times** are inherited so specifying test times is not necessary.  
  • Displayed are standardized times for which all CASAS tests are normed for accurate results.  
  • These times should not be edited unless –  
    o Configuring a session specifically for **Accommodations** requiring different timing for tests administered, or  
    o To adjust the pre/post-test time for academic hours such as a college class scheduled for only 50 minutes. |
| 21.  | ![Registration Tab](image) | • Now let’s move on to specify **what is collected** when testing.  
  o **Click the Registration tab.**  
  • **Click Inherited** to see default system settings.  
  • If your agency routinely imports student information from a 3rd **Party System**, then you would not be inclined to enable **Registration** settings.  
  • However, for purposes of this tutorial you will proceed to enable **Data Collection** screens. |
### Step 22

**Display**

- **Collect student demographics**
- **Collect statuses and goals**
- **Collect zip code**

**Description**

- For best practices, collecting and recording student information helps to –
  - Ensure data integrity, and
  - Provide details for program evaluation and analysis.
- Collecting student information through *eTests Online* eliminates scanning *Entry Records* when students have a **Class Enrollment** in *TOPSpro Enterprise Online*.
- Collect SSN was recently added and is not enabled by default.
- Collect ward is for programs that identify students within specified regions and not within zip code boundaries.
- For training, you will enable **three** data collection screens in addition to the Collect Program Information default already set.

**Note!**

- A **Data Collection Details** document is available on the CASAS website in *eTests Online Help* and *TOPSpro Enterprise Help*.

  - In the new version of *eTests Online*, data collection screens will include –
    - Address,
    - Phone, and
    - E-mail

### Step 23

**Display**

- **Toolbar display options**
  - Show toolbar pinned
  - Show toolbar
  - Show student name
  - Show form number
  - Show remaining items
  - Show remaining time
  - Show scale buttons

  **End test display options**
  - Show end test report
  - Show raw score
  - Show scale score
  - Show below accurate range (**)
  - Show conservative estimate (**)
  - Show pass/fail for GED/HiSET
  - Show levels and skills description
  - Allow print report

**Description**

- Now the last tab you will configure is to specify **what is displayed** during and at the end of each test delivered.
  - **Click** the Layout tab.
- Layout includes –
  - **Toolbar display**, and
  - **End test display options**.
- **Click Inherited** to see default system settings.
  - As you will see, most settings are already enabled.

**Note!** Checked information displays on the test screen during and after taking a test.
<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
</table>
| 24. | ![Toolbar display options](image1) ![End test display options](image2) | - You will apply **two** recommended settings to the **Toolbar** based on best practices.  
  - Click Edit.  
    1. **Check** Show toolbar pinned, and  
    2. **Click and clear box** on Show form number. |
| 25. | ![Toolbar Display](image3) | - Students may unpin and re-pin the **Toolbar** at any time during testing by hovering with the mouse at top of the test screen.  
  - Initially drawing the student’s attention to information displayed in the **Toolbar** may be helpful before they begin testing.  
  - Not showing the **form number** during test delivery may help to eliminate memorizing and sharing answers. |
| 26. | ![Personal Score Report (PSR) Display](image4) | - The **End-test report** known as the **Personal Score Report (PSR)** automatically displays at the end of a test with recommended settings already enabled by default.  
  - This report is a summary of the student’s performance on the test. |
## Step 27. Display Description

- Click the Admin tab.
- This tab specifies **how sessions are managed**.
- You will not be making an edits on the last tab.
- **Click Effective.**
  - These settings generally remain “as-is” unless there is a specific need to edit.

## Step 28. Display Description

- Before you save the **Instructional Program Template** and **first Session**, you will preview –
  - User **Edits** combined with
  - System-Inherited default settings.
- While in Effective mode,
  - **Click** each Tab and preview combined settings.
- If all looks good, at bottom of the **Edit Session Details** screen,
  - **Click Save**.

## Step 29. Template Intake: Locator + Pretest Session

- Now that the hard work is behind you and the Template and first Session is established, remaining sessions require only minor edits.
### Step | Display | Description
--- | --- | ---
- The **Template** established your standardized settings for –
  - **What gets delivered** – on the **Modalities** tab.
  - **How tests are delivered** – on the **Options** tab.
  - **What is collected when testing** – on the **Registration** tab.
  - **What is displayed during and at the end of each test delivered** – on the **Layout** tab.
  - **How sessions are managed** – on the **Admin** tab.
- The **Template** also created your first **Session** in a set of recommended sessions based on best practices.
- Any edit to the **Template** will have a simultaneous effect in editing all sessions sharing the same **Template** (per site).

30. ![Testing Sessions](image)
- Each session you add to your set of sessions will build on the last session.
- To add the second **Intake** session,
  - At left of the **Intake: Locator + Pretest** session,
    - Click **Copy**.

31. ![Session Description](image)
- Edit the **Session Description** to –
  - **Intake: Level A**.
  - Keep **LAB** and delete `<copy>`.

32. ![Modalities](image)
- On the **Modalities** tab, you will make **three** edits.
  1. **For Reading.**
  - Click the **Reading** field down-arrow.
  - From the drop-down menu,
    - Click **Select Form to Override with...**
### Step 33.

**Display:**

- From the pop-up,
  - **Click** 081R (Life and Work Reading Level A, Fixed Form).
- At bottom of the pop-up,
  - **Click** Select.
- The Reading modality now displays –
  - **Override with Single Form - 81R**.

### Step 34.

2. For Math,

- Click the Math field down-arrow.
- From the drop-down menu,
  - **Click** Select Form to Override with...

### Step 35.

- From the pop-up,
  - **Click** 031M (Life Skills Math Level A, Fixed Form).
  - **Click** Select.
- The Math modality now displays –
  - **Override with Single Form – 31M**.
### Step 

#### Display

![Image of testing session configuration](image)

#### Description

3. **For Listening,**

- **Click** the **Listening field down-arrow.**
  - From the drop-down menu,
    - **Click** **Select Form to Override with…**

4. **From the pop-up,**

- **Click** **981L (Life and Work Listening Form 981, Fixed Form).**
  - **Click** **Select**.

- The **Listening** modality now displays –
  - **Override with Single Form – 981L**.

5. **Click** the **Options tab.**

- Only **two** edits are needed on the **Options tab.**
  1. **Uncheck** and clear box on **Allow ‘I don’t know’ on locator/appraisal.**
    - This disables the ‘I don’t know’ button which does not apply to this session.
  2. **Check** Hide practice tests.

- Hiding **Practice Tests** is recommended at this level to simplify the **Test Menu** and because students have already been introduced to the test screen when following the **Intake Process** outlined for **ABE** and **ESL** programs.
### Step 39.

**Intake: Level A Session**

- The **Intake: Level A** session will inherit all other **Template** settings so no other edits are needed.
- **Click Effective** to see combined settings on all tabs.
- At bottom of the **Edit Session Details** screen,
  - **Click Save.**

### Step 40.

- Now you will customize the third **Intake** session and continue building the set of sessions sharing the same **Template** settings to ensure standardization.
- By copying, you benefit with combining settings applied to the previous session to continue adding sessions.
- From the **Intake: Level A** session,
  - **Click Copy.**

### Step 41.

**Beginning Literacy Reading**

- Assessing individuals whose literacy skills are at the lowest levels is simplified with the CASAS Beginning Literacy Reading Assessment.
- Use these two progress tests (pre- and post) to comfortably ease the testing experience for non-readers and beginning readers.
- Forms 27 and 28 are competency-based tests that focus on letter and word recognition and the concepts and conventions of print as they help instructors identify reading skill needs.

- Rename the **Session Description** to read –
  - **Intake: Beg. Lit.**
- Keep **LAB** and delete `<copy>`.
- If you want to add **Form 27R, or 28R** to the **Description** to be specific, that’s fine since **Beginning Literacy** is only available for **Reading**.
## Testing Sessions

<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
</table>
| **42.** | ![Modalities Tab](image1.png) | - On the **Modalities** tab, you will make **three** edits.  
  1. **For Reading.**  
     - Click the **Reading** field **down-arrow**.  
     - From the drop-down menu,  
       o Click **Select Form to Override with...**  
  2. **For Math, Beginning Literacy forms are not available.**  
     - Click the **Math** field **down-arrow**.  
     - From the drop-down menu,  
       o Click **Select Series (only Practice by Default)**.  
     - Selecting **Practice** on the **Modalities** tab, combined with **Hide Practice Tests** on the **Options** tab, cancels each other so that no **Math** buttons display on the **Test Menu**. |
| **43.** | ![Select Reading Fixed Form](image2.png) |  
  - From the pop-up,  
    o Click **027R (Life Skills Reading Beginning Literacy, Fixed Form)**.  
    o Click **Select**.  
  - The **Reading** modality now displays –  
    o **Override with Single Form – 27R**. |
| **44.** | ![Modalities Tab](image3.png) |  
  - **Override with Single Form – 27R**. |
Step 45. Display

### Intake: Beg. Lit. Session

#### Test Menu

**Reading Test**

**Form 27R**

**Form 28R**

Select Series (only Practice by Default)

- Click the Listening field down-arrow.
- From the drop-down menu,
  - Click Select Series (only Practice by Default).
- Just like Math, no Listening buttons will display on the Test Menu.
- All that will display on the menu is the Reading button for Form 27R or 28R, whichever you prefer to use.
- No other edits are needed on other tabs because the Beg. Lit. session will inherit a combination of settings applied to customized sessions and inherit Template settings.
- Click Effective to see combined settings on all tabs.
- At bottom of the Edit Session Details screen,
  - Click Save.

Step 46.

### Testing Sessions

- All three Intake sessions align with the recommended CASAS Intake Process for accurate test results and program placement.
- The most-used sessions will be the Intake: Locator + Pretest session and the Post-test session which is the next session you will add.
- From the Intake: Beg. Lit. session,
  - Click Copy.
<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
</table>
| 47.  | ![Session Description: Lab AC - Post-test](image-url) | - Rename the **Session Description** to read –  
  - **Progress: Post-test**.  
- Keep **LAB** and delete `<copy>`.  
- **The recommendation for when to post-test is after 70 - 100 hours of instruction** to document learning gains.  
  - The minimum allowed by **NRS** is 40 hours between pre- and post-tests.  

**Note!** Information is available on the CASAS website for **Next Assigned Test** charts.  

| 48.  | ![Modalities tab](image-url) | - You will apply **three** edits on the **Modalities** tab.  
- So that the session will inherit modality settings from the **Template** –  
  1. Uncheck **Reading**.  
  2. Uncheck **Math**.  
  3. Uncheck **Listening**.  
- The online system automatically assigns the next test form.  
- Students will **not take another Locator** even though the **Template** setting includes it.  
- The **test series + locator** setting is what causes the alternating effect of always presenting the next-appropriate test form and level based on the most recent test results recorded online.  

| 49.  | ![Registration tab](image-url) | - **Click** the **Registration** tab.  
- Only **one** edit is necessary on the **Registration** tab to avoid the risk of duplicated student records with mismatched test history.  
  1. **Check** Lock creation of new students.  
- Students tested with this session are required to enter a unique **ID** that pre-exists in your online database.  

---
## Testing Sessions

<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
</table>
| 50.  | Post-Test Session | - No other edits are needed for the Post-test session because it too will –  
  | |  - Inherit a combination of settings applied to customized sessions so far, plus  
  | |  - Inherit Template settings.  
  | |  - At bottom of the Edit Session Details screen,  
  | |  - Click Save. |
| 51.  | The next session to add in the set allows retesting in the same day if needed and if time permits.  
  | |  This session will give you the opportunity to retest a student on the same day if their pre- or post-test score is – |
| 52.  | These scores are displayed with an asterisk symbol (•).  
  | |  - Scores are inaccurate / invalid.  
  | |  - Retesting is required.  
  |  |  | These scores are displayed with a diamond symbol (♦).  
  | |  - Scores are accurate / valid.  
  | |  - Retesting is recommended.  
  | Note! Test administrators are encouraged to administer the next more difficult test level to obtain a more accurate scale score estimate. This is automatically set by the online system.  
| 53.  | From the Progress: Post-test session,  
  | |  - Click Copy.  
  |  |  | Rename the Session Description to read –  
  | |  - Retest Same Day.  
  | |  - Keep LAB and delete <copy>. |
### Step 54. Display

<table>
<thead>
<tr>
<th>Session Description:</th>
<th>LRA/AC - Retest Same Day</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validity Period:</td>
<td>7/1/2015 - 00:00</td>
</tr>
<tr>
<td></td>
<td>7/1/2015 - 00:00</td>
</tr>
</tbody>
</table>

**Modalities Tab**
- Reading
- Math
- Listening

**Admin Tab**
- Allow session to start in advance with
- Supervisory session for at least
- Supervisory session for at most

**Description**
- Again, you will make **three** edits on the Modalities tab to inherit Template settings.
  1. Uncheck Reading,
  2. Uncheck Math, and
  3. Uncheck Listening.

### Step 55. Display

<table>
<thead>
<tr>
<th>Session Description:</th>
<th>LRA/AC - Retest Same Day</th>
</tr>
</thead>
<tbody>
<tr>
<td>Validity Period:</td>
<td>7/1/2015 - 00:00</td>
</tr>
<tr>
<td></td>
<td>7/1/2015 - 00:00</td>
</tr>
</tbody>
</table>

**Admin Tab**
- Allow session to start in advance with
- Supervisory session for at least
- Supervisory session for at most

**Description**
- To allow retesting in the same day,
  - Click the Admin tab to apply **one** edit.
- For Days between tests of the same modality,
  1. Enter ‘0’.
- No other edits are needed for the Retest Same Day session because it too will inherit all other settings combined.
- At bottom of the Edit Session Details screen,
  - Click Save.

### Step 56. Display

<table>
<thead>
<tr>
<th>Session Full Name</th>
<th>Site</th>
<th>Start Date / Time</th>
<th>End Date / Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retest (LRA/AC-05 - Instate - Locator)</td>
<td>Central Library</td>
<td>7/1/2015 / 08:00</td>
<td>7/1/2015 / 09:00</td>
</tr>
<tr>
<td>Retest (LRA/AC-05 - Instate - Level A)</td>
<td>Central Library</td>
<td>7/1/2015 / 08:00</td>
<td>7/1/2015 / 09:00</td>
</tr>
<tr>
<td>Retest (LRA/AC-05 - Instate - Level B)</td>
<td>Central Library</td>
<td>7/1/2015 / 08:00</td>
<td>7/1/2015 / 09:00</td>
</tr>
<tr>
<td>Retest (LRA/AC-05 - Retest Same Day)</td>
<td>Central Library</td>
<td>7/1/2015 / 08:00</td>
<td>7/1/2015 / 09:00</td>
</tr>
</tbody>
</table>

**Description**
- Next, you will add a session to address students who return after being absent from instruction.
- NRS recommends after 90 or more days to administer another appraisal to determine the appropriate-level test at time of return.
- When the student returns, the locator is given again to determine the appropriate test.
- From the Retest Same Day session,
  - Click Copy.
<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
</table>
| 57. | ![Session Description: LAB-AC - Returning after 90+ days absence](image) | - Rename the **Session Description** to read –
  - Returning after 90+ days absence.
- Keep **LAB** and delete `<copy>`.
- This description is to distinguish this session from the **Post-Test** session where students who are actively receiving instruction are tested to document learning gains. |

| 58. | ![Modalities Configuration](image) | - For the session to inherit **Modalities** from the **Template**, you will make **three** edits.
  1. **Uncheck** **Reading**.
  2. **Uncheck** **Math**.
  3. **Uncheck** **Listening**. |

| 59. | ![Session / template Configuration](image) | - **Click Options** to apply **three** edits.
  1. **Click** and return dash on **Allow ‘I don’t know’ on locator/appraisal setting** to inherit the **Template** setting (i.e., re-enable this option).
  2. **Check** **Use locator/appraisal for next test** to force the online system to administer the **Locator** again.
  - By design, the online system will **not** automatically administer the locator again.
  - Because of this design, you have to apply an override.
  3. **Click** and return dash on **Hide practice tests** to inherit the **Template** setting which allows students to practice before testing. |

*Note!* The reason a locator or appraisal is administered again when a student returns after being absent from instruction for 90+ days is because the NAT (which is based on the last test a student took and would otherwise be presented to the student at time of return) is not necessarily appropriate given the elapsed period.
### Testing Sessions

<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
</table>
| 60.  | ![Image](image1.png) | - Now you need to remove the **one** edit on the **Admin** tab.  
- **Click** the **Admin** tab.  
  1. Remove ‘0’ from **Days between tests of the same modality** so the box is empty and the session inherits **Template** settings.  
- No other edits are needed for the **Returning** students session because like the other sessions, it too will inherit all other settings combined.  
- The **Test Menu** will deliver and display the same as the **Intake: Locator + Pretest** session with the exception that – |
|      | ![Image](image2.png) | **61. Returning after 90+ days absence Session**  
  - **Test Menu** is enabled on the **Registration** tab from a previous session setting so that students **must** enter a pre-existing unique **ID**.  
  - The purpose of requiring students to enter a pre-existing **ID** is to avoid duplicate records of the same student and mismatched test history.  
  - **Click Effective** to see combined settings on all tabs.  
  - At bottom of the **Edit Session Details** screen,  
    - **Click Save.** |
| 62.  | ![Image](image3.png) | - **The next session to add is for Registration.**  
- **This session gives you the opportunity to separate the registration process from the testing process to give you undivided time to assist students with applying responses and addressing their questions.**  
**If you use the Registration session**  
  - Data collection screens are skipped during an **Intake** session and students begin testing after entering an **ID, first and last name**, and saving their new student record.  
**If you do not use the Registration session**  
  - Students will complete the registration process during an **Intake** session before they begin testing. |
63. From the Returning students session,
   - Click Copy.

64. Rename the Session Description to read –
   - Registration.
   - Keep LAB and delete <copy>.

65. Three edits are needed on the Modalities tab.
   1. For Reading,
      - Click the Reading field down-arrow.
      - From the drop-down menu,
        - Click Select Series (only Practice by Default).
      - Because this is a testing application, all sessions must have Modalities enabled.
        - With Registration, students have the opportunity to practice before testing.

66. 2. For Math,
      - Click the Math field down-arrow.
      - From the drop-down menu,
        - Click Select Series (only Practice by Default).
### Step 67

<table>
<thead>
<tr>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Display" /></td>
<td>3. For Listening,</td>
</tr>
<tr>
<td></td>
<td>- Click the Listening field <strong>down-arrow</strong>.</td>
</tr>
<tr>
<td></td>
<td>- From the drop-down menu,</td>
</tr>
<tr>
<td></td>
<td>- Click <strong>Select Series</strong> (only Practice by Default).</td>
</tr>
</tbody>
</table>

### Step 68

<table>
<thead>
<tr>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image2" alt="Display" /></td>
<td><img src="image3" alt="Display" /></td>
</tr>
<tr>
<td></td>
<td>1. Click and remove dash to clear box on <strong>Allow ‘I don’t know’ on locator/appraisal</strong> and disable the <strong>Template</strong> setting since this setting does not apply to Practice Tests.</td>
</tr>
<tr>
<td></td>
<td>2. Check <strong>Allow ‘I don’t know’ on pre/post-test</strong> to mimic this choice on a <strong>Locator</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. <strong>Click and return dash on Use locator/appraisal for next test</strong> to inherit the <strong>Template</strong> setting.</td>
</tr>
</tbody>
</table>

### Step 69

<table>
<thead>
<tr>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image4" alt="Display" /></td>
<td>5. <strong>Click Registration</strong> to apply <strong>two</strong> edits.</td>
</tr>
<tr>
<td></td>
<td>1. <strong>Click and return dash on Lock creation of new students</strong> to inherit the <strong>Template</strong> setting so that new student records may be added to your online database during <strong>Registration</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. <strong>Click and remove dash to clear box on Collect program information</strong> to disable the <strong>Template</strong> setting since program placement is yet to be determined.</td>
</tr>
</tbody>
</table>
Testing Sessions

<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
</table>
| 70.  | ![Image](image1.png) | • Click the Layout tab to apply one edit.  
  1. Click and remove dash to clear box on Show remaining time to disable the Template setting.  
  • Because Practice mimics pre/post-testing with standard 60-minute test time,  
    o Showing time remaining for a 6 or 9 item Practice may alarm students if they saw this amount of time in the retractable Toolbar. |
| 71.  | ![Image](image2.png) | • No other edits are needed for the Registration session.  
  • Data Collection screens will be presented to students followed by a Test Menu that only offers Practice Items.  
  • Click Effective to see combined settings on all tabs.  
  • At bottom of the Edit Session Details screen,  
    o Click Save. |
| 72.  | ![Image](image3.png) | • The last session in this set is for Practice.  
  • This session will give students the opportunity to practice without risk of launching into a test.  
  • From the Registration session,  
    o Click Copy. |
| 73.  | ![Image](image4.png) | • Rename the Session Description to read –  
  o Practice.  
  • Keep LAB and delete <copy>. |
## Testing Sessions

<table>
<thead>
<tr>
<th>Step</th>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
</table>
| 74.  | ![Session Configuration](image) | - Only **four** edits are needed for the **Practice** session.  
- **Click** the **Registration** tab.  
- **Click** to remove checks and dashes to clear boxes and disable **Template** settings for –  
  1. Collect student demographics.  
  2. Allow update on student information.  
  3. Collect statuses and goals.  

| 75.  | ![Practice Session](image) | - As with all other sessions in the set, the **Practice** session will inherit combined settings.  
- **Click** **Effective** to see combined settings on all tabs.  
- At bottom of the **Edit Session Details** screen,  
  - **Click** **Save**. |
| 76.  | ![Testing Sessions](image) | - You now have a set of **8** customized **Testing Session** records sharing the same **Template**.  
  - At **one Site**.  
  - In **one Lab**.  
  - For **one Instructional Program**.  

### CONGRATULATIONS!

Your work on establishing a standard set of sessions is done for the entire program year. Now all that remains is to –  
- **COPY** sessions in the same order as created to retain combined settings and –  
  - Add sets for other **Labs** within the same **Site**.  
    - Copy and **only edit Session Description** to include **Lab** name, remove “<copy>” from **Session Description**, and then **Save**.  
  - Add sets for other **Sites**.  
    - Copy and select new **Site**, remove “<copy>” from **Session Description**, and then **Save**.  

Prepare for the new **Program Year (PY)**!  
- Use the new **Batch Replicate** feature in **TE** to copy a group of sessions into the new program year with the **Click** of a button!